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MX-View 1.4 and MX-OS 3.10 maintenance changes and new
feature implementation notes

New Features

Pencil Tool
The pencil tool provides the ability to repair audio events that suffer from a pop or click.
In order to use the pencil tool, the following criteria must be met:

1. The waveform zoom level must be fully zoomed in (+) so that the audio waveform is displayed down to
the sample level. Attempting to alter the waveform data at any zoom level other than the sample level will
have no effect.

2. The entire audio event, which contains the waveform to be edited, must be set to full gain.  Attempting to
alter the waveform data of an event that has gain less than maximum will have no effect. This applies to
any portion of the event waveform.

3. No portion of the audio event that has an applied fade will be editable. This includes any portion of the
event that is ramped up/down or cross-faded. Attempting to alter the waveform data in the region of an
event where fade is applied will have no effect.  This applies only to the region where fade is applied.

4. No portion of overlapping audio events will be editable. This applies even if both events are at full gain
and there is no fade. Overlapping audio events are mixed whether there is fade or not and mixed waveform
data cannot be edited.

To use the pencil tool, click and drag on the portion of the waveform that you wish to change.  As you drag,
the waveform will be altered and redrawn as you move the pencil, much the same as with a pencil tool in a
graphics drawing program. However, unlike a drawing program the pencil tool will always draw over the
waveform as you move it left and right so that there is always just one value per sample.

If pencil tool editing is first applied in a valid portion of the waveform and the pencil tool is then moved
over a faded region, the tool will affect only that portion of the waveform that is not faded.

When the mouse button is released, the altered waveform data is sent to the MX-2424 as a single unit.

This action is undoable and redoable. If you make 2 pencil edits (2 mouse ups) and then select undo twice,
the waveform will be back to what it was originally.

To cancel a pencil edit in progress, press the escape key; the waveform data will be reverted to the original
form.

When using the pencil tool, the result is that the original audio sample data from the sound file is altered
each time you release the mouse. Note that this may actually affect more than one track or clip if you have
made any copies of the audio event.

Because the pencil tool alters the original sound file, you can take advantage of this if you need to get
around limitations 2-4 above. Just copy the portion of the audio event that you wish to edit to a blank area
of a track, adjust the gain to maximum, remove any fades or overlaps and then zoom in to the sample level
and edit the waveform. All audio events that reference the affected sound file will then reference the altered
data.



Reverse play keyboard shortcuts
The reverse play button on the Transport Window now has a shortcut key.
On Mac it is Opt-Spacebar and on Windows it is Alt-Spacebar.

Selection Tool Changes
Hand Tool (pointer) operations:
• With any active user group(s), clicking (on mouse down) on an audio event will not select that event if

the track is not in the active group(s) unless the shift key or ctrl key is held down.
• With any active user group(s), drag selecting audio events outside of tracks in active user groups is

disabled unless the shift key is held down.
• With any active user group(s), drag selecting an audio event in a track where the track belongs to an

active user group will cause all tracks belonging to any active user group to be editable (edit status on).
• With any active user group(s), clicking on a track without dragging the mouse with the ctrl or shift

keys (but not both) held down and where the clicked track belongs to a active user group will likewise
alter the edit state for all tracks in all active user groups.

• With any active user group(s), dragging an audio event from one track and dropping it on another track
will account for user groups. If the track the event was dropped on belongs to an active user group, all
tracks for all active user groups will become edit enabled.

Selector Tool (crosshair) operations:
• With any active user group(s), clicking on a track without dragging the mouse with the shift key held

down and where the clicked track belongs to a active user group will likewise alter the edit state for all
tracks in all active user groups.

Track Numbering with multiple machines
With multiple machines in a edit window, track numbers are displayed in increasing order beginning with
track 1 at the top and with the first track of additional machines beginning at one greater than the last track
of the previous machines.

Default Download File Type
MX-View now remembers the last selection made for download file type and uses that as the default until
the user specifically chooses a different download file type. This applies only to the download audio file
dialog.

Batch download
With the Import/Export Audio window open, select multiple files and then select "Batch Download" from
the File Menu. In the batch download dialog, select the location and file type for the downloaded audio
files. The progress of each download will be shown in the Import/Export Audio window.

Halting the download will cancel only the download of the file in progress and any remaining files.

Virtual Track Present Indicator
Any track that has virtual tracks created has the expander triangle colored blue.



Logarithmic and Exponential Fade Types
Fade Changes
Multitrack Selections and the Fade Command

With selector tool (arrow cursor), it is now required that multi-track selections must be such that the
resulting fade will be the same on all selected tracks or the Fade command will not be enabled.

THIS IS A CHANGE - previously, the requirement for the Fade command was just that for each track, the
selection in/out points had to be such that an audio event (or audio events for crossfades) was correctly
positioned around in/out so that a valid fade could be calculated. In other words, the affected sound event
on track 1 could have been ramped up, the affected event on track 2 could have been ramped down and 2
events on track 3 could have been cross faded.

NOW - All tracks contained within the selection must have events positioned such that they all would be
ramped up, ramped down or cross faded. No combinations allowed!  Note that the reason for this is that the
UI has changed to allow the user to select the type of fade curves. This cannot be done unless all fades for
multiple tracks are of the same type.

Summary of Fade operations:
Create fade with Selector tool (crosshair) selected
• Create an edit selection, then select the Fade command from the Edit Menu (cmd-F / ctrl-F).
• Select the desired fade curve from the dialog box.
• If the selection covers the right end of one event and the left end of another event, this will create a

cross-fade, and a cross-fade dialog will be shown.
• If the selection only covers the left or right end (but not both) of a single event, this will create a ramp-

up or ramp-down (fade in / fade out), and the appropriate ramp dialog will be shown.

Edit fade with Selector tool (crosshair) selected
• Double click on an existing fade (either a cross-fade or a ramp up/down). The appropriate fade dialog

will be shown. Select the new fade shapes and click OK.

Event copy/paste for non-contiguous selections
Using the Hand tool (arrow pointer), changes have been made to MX and MX-View software to allow for
non-contiguous audio event selections.

With non-contiguous selections, the clear command will only clear the selected events, leaving any non-
selected events in place (previously, the clear command would clear everything on the track from the first
selected event to the last).

Copy and Paste work just like they did previously, however a new item has been added to the Edit Menu to
allow for transparent pasting. With normal Copy/Paste and non-contiguous selections, the Paste location
will be overwritten with the copied audio events, INCLUDING any blank space.

If two events are selected with an intervening event, only the 2 selected events are copied but the
intervening space is also copied. Doing a normal paste results in the blank space being pasted over the top
of anything existing at the paste location. When this is not desired, select the new "Paste Transparent"
menu item from the Edit Menu. The result will be that only the copied audio events will be pasted at the
past location. The intervening blank space will not be pasted.



Track locking
A new item has been added to the track pop-up menu, "Lock Track" / "Unlock Track".  A locked track
cannot be edited and cannot be selected for recording. A locked track will also disable other track pop-up
menu items so that the locked track cannot be deleted or renamed. Audio events on the locked track cannot
be selected, dragged, copied, deleted or renamed.

• Select the "Unlock Track" item to unlock a locked track.

Zero crossing centerline
A new audio event 0db centerline is now available. It is selectable on/off in view menu.

Keystroke forwarding from Markers and Groups windows
The markers and user groups windows now pass most keystrokes to the edit window.  This enables most
keyboard shortcuts in the edit window (all transport commands for example).

The only keys that are intercepted by the markers and groups windows (and not sent to the edit window)
are:
Markers Window
• Up arrow
• Down arrow
• Enter/return key
• Shift-cmd-N (Mac) or shift-ctrl-N (Windows)
• Cmd-W (Mac) or Ctrl-W (Windows)
• Cmd-Q (Mac) or Ctrl-Q (Windows)
• Opt-Cmd-R (Mac) or Ctrl-Alt-R (Windows)

Groups Window
• Up arrow
• Down arrow
• Enter/return key
• Shift-cmd-N (Mac) or shift-ctrl-N (Windows)
• Cmd-W (Mac) or Ctrl-W (Windows)
• Cmd-Q (Mac) or Ctrl-Q (Windows)
• Opt-Cmd-R (Mac) or Ctrl-Alt-R (Windows)
• Cmd-G (Mac) or Ctrl-G (Windows)

Keyboard shortcuts for jump to Head/Tail
The Head and Tail buttons on the Transport Window now have shortcut keys.

Mac:
Head = Opt + Shift + left arrow
Tail = Opt + Shift + right arrow

Windows:
Head = Alt + Shift + left arrow
Tail = Alt + Shift + right arrow



Timecode Chase menus added to Settings Menu 000 (Basic Settings)
The MX has added 4 new machine settings menus to the basic settings (000).  The new items are menus
021 (Chase Sample Ref), 022 (Chase Freewheel), 023 (Chase Relock), and 024 (Relock Threshold). These
menus are also now available in MX-View on the Basic Settings (000) dialog.

021 Chase Sample Ref

    Frame [LTC only](default)
    Internal

This is a new feature, and is relevant only to LTC chase.  When the
previous version of the MX was chasing timecode, the sample clock
was locked to the frame edges of the incoming Longitudinal Time
Code, unless some other specific clock source had been selected.  This
new menu allows the user to opt out of this scheme, and to continue
running the MX from its internal clock.
Exceptions:  This selection will be overridden if another frame or clock
reference has been specifically selected e.g. Video, Ext Wordclock, etc.

022 Chase Freewheel

    5 frames

    10 frames       (default)
    20 frames

    50 frames

    100 frames

This menu allows the user to select the number of frames of “bad”
master timecode through which the MX will “freewheel”.  If the master
continues issuing bad timecode beyond this number of frames, then the
MX will decide that the master is no longer playing, and will exit play
mode.

023 Chase Relock

    On

    Off If Recording (default)
    Off Always

This menu allows the user to control the behavior of the MX when it
detects that its position has drifted away from that of the master either
because the MX and the master are running at slightly different rates or
because the master has jumped to a new position.  In previous versions,
the MX would simply “relock”, which meant jumping to a new position
to be synchronous with the master. Two new options allow the user
either to inhibit the relocking action when the MX is recording, or to
inhibit it altogether.



024 Relock Threshold

    Automatic       (default)
    1/3 frame

    1 frame

    2 frames

    5 frames

    10 frames

This menu determines the size of the error between the MX and the
master which must be detected before a “relock” will take place [see
above].  In the “Automatic” mode, the threshold is set to 1/3 frame for
LTC chase and 10 frames for MTC chase.
Note: If menu “023 Chase Relock” has inhibited the relock
action, and if the lock error has exceeded the threshold specified in
this menu, then the front panel “CHASE LOCK” LED will flash to
indicate that condition.

Lock Error Display
A new lock error display has been installed which will show the amount of deviation of the MX’s position
from that of the LTC or MTC chase master.  The format of the display is:

ERR   00:00:00:00
If the MX is not specifically chasing LTC or MTC then this display will show all zero’s.  However, if the
MX is chasing and locked, but with the “relock” function disabled, then this “ERR” display is useful for
monitoring the current amount of drift.
The ERR display is accessed from the front panel by pressing Shift + ONLINE, and from the RC-2424 by
pressing Shift + LOOP.  (Circumstances did not permit the use of the same keystrokes in both
environments.)  It is neither necessary nor prohibited to preceed these keystrokes with the RCL key.

Timecode Lock Deviation display added to Edit & Transport Windows (MX-View)
A new lock error display has been added to the edit menu machine info bar which will show the amount of
deviation of the MX’s position from that of the LTC or MTC chase master.  The chasing MX must be
selected as the current transport focus in the Transport window.  If the MX is not specifically chasing LTC
or MTC then this display will show all zeros.  However, if the MX is chasing and locked, but with the
"relock" function disabled, then this display is useful for monitoring the current amount of drift.  Note that
when chase locked, a yellow circle with the letter "L" is displayed in the timecode display of the chasing
machine in the Transport window.

When the MX determines that drift is excessive, it will begin to flash the "CHASE LOCK" LED on the
chasing MX's front panel. This can also now be seen as the chase lock indicator flashes in the Transport
Window.



More MEMORY Registers
• The number of memory registers in the MX-2424 has been increased to 255, all of which will be

accessible from MX-View.
• The number of memory registers displayed at the front panel (and RC-2424) may be controlled by a

new menu, with selections for 100 or 255 Memory Registers.  The setting of this menu does not affect
the number of internal registers, only the number that can be viewed at the front panel (or RC-2424).

272 Memory Registers
    100             (default)
    255

• For 100 Memories, each may be accessed by STO/RCL/CAPT plus two digits: 00 thru 99.
When 255 are selected, three digits will be required to specify the memory number: 000 thru 254.
[If a number larger than 254 is entered the error message  MEM Out of Range  will be displayed.]

MEMORY Register Scrolling
• Once a MEMory register has been displayed on the LCD, the Up/Down Arrow keys may be used to

scroll through all memory registers.  Upon reaching the highest or lowest location the MEMory
number will “wrap around” and keep incrementing/decrementing.  Holding an arrow key down will
invoke key repeat.  The JOG wheel may also be used.

Marker Capture
• A front panel (and RC-2424) Marker/MEMory Capture with Auto-Increment function has been

implemented using the Up Arrow key.
• To capture a Marker and automatically increment the MEMory number, press CAPT then Up Arrow.

The targeted MEMory register will be displayed, and will contain the captured transport timecode
value.  It is not necessary to be displaying the MEMory location prior to pressing this key sequence.
[If no more Marker/MEMory locations are available, the error message  End of MEM Markers
will appear.]

• An internal counter keeps track of the “Next Marker” register, and its current setting may be viewed by
pressing RCL then Up Arrow.  The display will show  MEMxx  Next Marker .

• To begin marking at a new MEMory location, display the desired MEMory, then press STO then
Up Arrow.  The same  MEMxx  Next Marker  display will appear.  [If a MEMory register is not
on display prior to pressing these keys, then the error message  Needs MEM Display  will appear.]

• When a new project is loaded, or initiated, the MX will scan the MEMory registers to find the lowest
numbered register which contains a timecode value of zero.  That register will become the “Next
Marker” register, and will be the target of the next Marker capture.  If none of the loaded MEMories
have a zero value, then register 00 will be the “Next Marker” register.



Memory Register Changes (MX-View)
The MX now has 255 memory registers. The following changes were also made to MX-View.

• Changed the image for the memory register on the Time Ruler (wider to accommodate 3 digits).
• Always display up to 255 registers (even if MX is set to only display 100). The MX always has 255, it

just limits the front panel to 100 (2 keystrokes) or 255 (3 keystrokes).
• To capture or navigate to a marker, always enter 3 digits (Marker 2 requires entry of 002).
• The markers window has been expanded to allow for 255 markers.
• When capturing or navigating to a marker in multi-machine mode and without using TL bus or

Timecode chase, the only machine affected is the one with transport focus. i.e. - the machines are
treated individually.

• Changed the logical rotation order when capturing markers to match the MX. When a new marker is
captured, the current list of markers is searched for the first empty marker. If markers 0 through 10 are
created, then markers 3 and 7 are deleted, then next marker created will be 3, then 7, then 11.
Basically, the holes in the marker list are always filled first before adding to the end of the list. Once
all marker numbers have been used up (0 to 254 on the MX), the next marker number will rotate to 0.

Edit Enable (MX-View)
Applies to multi-machine mode only (multiple machines in one edit window).
Note that in the following, "undo" is used for undo or redo (they are affected the same by this change).

A new machine level button (undo Enable) has been added in the machine buttons area.  The button is an
"E" within a circle, very similar to the online button ("O" inside circle).  This button is both a control and
an indicator. If ON, when an edit is performed (from the edit menu, the keyboard, or the toolbar), the edit
command is sent to that machine.

If this indicator is off, that machine is disabled for editing. In other words, with multiple machines, only
those machines that have the "Edit Enable" button ON (enabled) will receive edit commands.

Clicking on the button will toggle it to the opposite state, allowing the user to actively control the enabling
of Undo/Redo for that machine.

MX-View is now more "smart" about sending Undo/Redo to multiple machines in an edit window.
Whenever an Undoable command is sent to the MX, the "Edit Enable" status for that machine is turned on
(enabled). Likewise, if a global command is given (e.g. - "Cut" is selected from the Edit Menu), but only
one machine has edit enabled tracks with selected events, then only that machine's "Edit Enable" button
status will be turned on, and all other machines will have their Edit Enable buttons disabled. The end result
is that for normal workflow, Undo and Redo commands will now be sent selectively to the correct
machines.

It is no longer necessary (or even possible) to control which machine the Undo/Redo commands will be
sent by changing the transport focus in the transport window.

In the Transport Window, a new "Edit" button will be visible when there are multiple machines in an edit
window. This button works the same as the "Online" button in that it will control the "Edit Enable" button
of the machine that has the transport focus.

This is for convenience only. Each machine's undo Enable button can always be directly controlled
regardless of the transport focus.



Maintenance Items

Numerical entries can be made without placing a new Marker
Pressing the Enter/Return key after entering digits into timecode displays was creating a new Marker
Location (memory register). This has been fixed – Markers are only created when the focus is on the edit
window.

Multi-machine mode event dragging
In previous versions of MX-View, in multi-machine mode (single edit window with multiple machines)
and with the machines connected on the TLBus and Online, selecting and moving an event resulted in
undefined behavior on the MX. This has been corrected.

Edit window behavior with missing/offline machines
If MX-View is quit while an edit window with multiple machines is open, when MX-View is next started it
will attempt to reconnect to those machines and restore the edit window to the same state.  If any of the
previously connected machines cannot be found (they were either shutdown or disconnected from the
network), MX-View will now attempt to restart the connection with only those machines that it can find.

Timecode Chase Update
The MX-2424 will now better detect the current state of the time code master.   More specifically, there
have been improvements in the method by which it distinguishes between a master, which is no longer at
play speed, and one that is still playing but has either drifted or jumped to a new position.  Previous
versions of the software could mistake either one of these conditions for the other.

Disk Command Menu Behavior
The disk formatting menus will now always retain the most recently selected disk number when the STO
key is pressed, whether the resulting action produced an error or not.
Affected Menus:
710 Disk Initialize
711 Disk Low Format
720 Disk Cleanup
730 Backup Erase

Memory handling of the Undo History
As of MX-OS version 3.10, 256MB of RAM will be required for 100 levels of Undo.  An MX-2424 with
128MB of RAM will be limited to 50 levels of Undo in order to prevent out of memory conditions during
loop record.
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